
Fonter 6.2
The Windows Font

Viewer/Previewer/Installer
Un-Registered Shareware Version

INTRODUCTION 
Windows 3.1 lets you use fonts quickly and easily. Using Windows 3.1's 
TrueType fonts, or Adobe Type Manager, you can have access to 
thousands of typefaces, all of which will work in any Windows program.
But there's a problem. It's often difficult to choose just the right font for
the job. That's where Fonter comes in. It lets you view any ATM or 
TrueType font on the screen, in several ways. Even better, Fonter lets 
you create printed lists of all your fonts, with a text sample of each 
font. You can also print sample sheets or character set charts that will 
show you just what characters are in every font.

Windows uses the ANSI character set, which not only includes normal 
keyboard characters, but foreign language and symbolic characters as 
well. Some fonts contain different characters. You need a way to see 
the characters in each font you want to use. Fonter lets you do that 
quickly.

Dingbat and symbol fonts contain special characters, but they aren't 
regular keyboard characters, so it's hard to know what character you'll 
get when you press a key. Fonter lets you see every special character, 
along with the key to press. 
New in this version of Fonter is the powerful ability to preview TrueType
fonts before you install them. Fonter can also install new TrueType 
fonts either temporarily for a single session of Windows, or 
permanently, as you choose.

FONTER'S FEATURES
Supports Adobe Type Manager Fonts
Supports TrueType Fonts
Supports all 100% Windows-Compatible Printers With Correct Drivers
View Any Character of Any Font
Zoom View of Any Character
Keyboard Display Shows All Standard Characters.
Print Keyboard Templates for Symbolic and Dingbat Fonts
ANSI Character Grid on Screen and Printer
Save Any Character as a .BMP Clip Art File



Print Full or Partial Font Lists With Samples
Print Full-Page Font Samples
Print ANSI Charts
Print Keyboard Templates for Any Font
Print Complete or Partial Font Books
NEW FEATURES IN THIS VERSION
Preview TrueType fonts on any drive, even network and CD-Rom Drives
Print Specimen sheets of previewed fonts.
Install TrueType fonts for a single session in Windows
Install True Type Fonts permanently
Printer Setup Command
Right-Click Help for On-Screen Commands

LICENSE INFORMATION
This is the unregistered version of Fonter 6.2. Fonter is a shareware 
program. You may try this copy of the program for a period not to 
exceed 30 days to determine whether or not it is suitable for your 
needs. After that time, if you continue to use the program, you must 
register your copy with the author. To register, use the OsoSoft 
Program Info command in the Help Menu to print the registration form. 
The Registration fee for this program is $20.

You can also register with a Visa or MasterCard by calling OsoSoft at 
(805) 528-1759 during normal West Coast business hours. Credit card 
orders incur a $4 shipping and handling fee for each order, regardless 
of how many programs are ordered. OsoSoft programs may also be 
registered on CompuServe in the SWREG forum. Registrations will be 
charged to your CompuServe account.

Registered users receive the very latest version of the program, a 
printed manual, automatic notification of major upgrades, and support.
In addition, when you register, you'll always be entitled to upgrade to 
new registered versions at no charge on the OsoSoft BBS at (805) 528-
3753. Registered users are entitled to unlimited free support by 
telephone, fax, on the OsoSoft BBS, and on Compuserve.

Unregistered users receive only a minimum of support, limited to some
installation help, if necessary, and are not entitled to telephone 
support. If you call the OsoSoft voice number for support as an 
unregistered user, you will be asked to register at that time by credit 
card.�

Users of this program, along with traditional shareware distributors 
may distribute copies of  the shareware versions of this program, but 
only under the terms described in the VENDOR.DOC file included with 



this copy of the program. All commercial distributors MUST read that 
file and abide by the distribution rules contained in that file. Violations 
of the distribution license in VENDOR.DOC may result in prosecution 
under appropriate copyright laws of the United States and other 
countries.

Fonter and all related files, including this documentation are Copyright 
1991,1994 by OsoSoft. All rights are reserved.

OsoSoft is a member of the Association of Shareware Professionals and
the Software Publishers' Association.

OsoSoft
1472 Sixth Street
Los Osos, CA  93402
OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
CompuServe ID: 71571,222

HOURS
OsoSoft business hours are 7 AM to 4 PM, Pacific Time, on weekdays. 
Calls outside those hours are not appreciated.

ASP OMBUDSMAN NOTICE
This program is produced by a member of the Association of Shareware
Professionals (ASP). ASP wants to make sure that the shareware 
principle works for you. If you are unable to resolve a shareware-
related problem with an ASP member by contacting that member 
directly, ASP may be able to help. The ASP Ombudsman can help you 
resolve a dispute or problem with an ASP member, but does not 
provide technical support for members' products. Please write to the 
ASP Ombudsman at 545 Grover Road, Muskegon, MI 49422-9427 USA 
FAX 619-788-2765 or send a CompuServe message via CompuServe 
mail to ASP Ombudsman 70007,3536.

INSTALLATION
The Shareware and Online Update versions of Fonter use a manual 
installation technique. The Full Registered Version includes an 
automated installation program. To install this program, take the 
following steps. If you need help with any of the file and directory 
procedures, consult your Windows or DOS Manual.

1. Copy all files from the distribution diskette or the ZIP file containing 
the program into a directory on your hard disk. OsoSoft recommends 
that you create a directory called FONTER for the files.



2. Now, copy all files with the extensions .DLL and .VBX from the 
FONTER directory into your WINDOWS\SYSTEM directory. If you're 
working from the DOS prompt while in the FONTER directory, the 
commands would be:

COPY *.DLL C:\WINDOWS\SYSTEM
COPY *.VBX C:\WINDOWS\SYSTEM

Naturally, you'd substitute your own drive and directory information if 
you installed Windows in a different directory.

NOTE: Once you have successfully copied all DLL and VBX files into the
WINDOWS\SYSTEM directory, you may delete them from the Fonter 
home directory, if desired, to save disk space. Do not, however, delete 
any other files.

VBRUN300.DLL REQUIRED
The shareware and online update versions also require VBRUN300.DLL,
which must be installed in the WINDOWS\SYSTEM directory. If you do 
not have a copy of that file, you may download it as VBRUN300.ZIP 
from the OsoSoft BBS at (805) 528- 3753, or obtain it from the source 
where you got your copy of the shareware version.

3. If Windows is not running, start it. Then, from the Program Manager, 
click once inside the program group where you want the Fonter icon. 
Then, select the New command from the Program Manager's File menu.
Make certain the Program Item option is selected, then click OK or 
press <Enter>.

4. In the Description field of the resulting dialog box, type Fonter, then 
press <Tab>.

5. In the Command Line field, type C:\FONTER\FONTER.EXE, 
substituting other drive and directory information, if necessary. Press 
<Tab>.

6. In the Working Directory field, type C:\FONTER, or substitute other 
drive and path information, if necessary.

7. Press <Enter> or click OK to complete the installation. The Fonter 
icon will appear in the program group you selected earlier.

SYSTEM REQUIREMENTS 
Fonter requires a 386S or better PC, Windows 3.1 operating in 



Enhanced Mode, and a minimum of 2 MB of memory. You'll also need 2 
MB of disk space for installation and up to 6 MB of free disk space for 
TMP files if you use Print Manager. NOTE: For fastest results, turn 
Print Manager off in the Control Panel's Printer Setup 
application before starting Fonter. You'll also need a fully-
supported Windows-compatible printer with a 100% correct printer 
driver and a valid video display with 640 X 480 resolution minimum.

SYSTEM LIMITATIONS 
Fonter works only with TrueType and Adobe Type Manager scalable 
fonts. It is untested with other font scaling software.

Defective Fonts 
Some TrueType and Adobe PostScript fonts have defects. This can 
cause Fonter or other Windows software to crash. For more 
information, see the Troubleshooting section at the end of this manual.

RUNNING FONTER 
To start Fonter, double-click its icon in the Program Manager. The first 
time you run the program, it will create a list of your fonts and save the
list in a file. This process can take a minute or two. You'll see a window 
telling you what's going on. If your font list changes, Fonter will 
automatically rebuild the font list.

Right-Click Help: Any time you want help with a command or other 
on-screen item in Fonter, right click on that item and look for the help 
line in the program's title bar.

USING FONTER WITH INSTALLED FONTS
Once Fonter starts, you'll see its main window. At the top left of the 
screen, you'll see the Font Sample window, which displays a sample 
of the first font in your font list. 
At the lower right, you'll see a list of the fonts you have available for 
your printer, with a font count just below the list. You'll also see the 
font type listed above the list box. 

NOTE: Fonter only displays the root font for TrueType fonts which have 
separate files for each font weight in this list. When you select a 
TrueType font for viewing, another list box will appear, showing you the
weights for which you actually have an installed font file. If you select 
the Bold and Italic options, or one of the listed weights Windows will 
load the correct font file. Because of this, your font count may not 
agree with that in ATM or the TrueType control panel. 

To the left of the Font List window are a number of option check boxes



and other Fonter options. To see an alphanumeric sample of any font, 
click on the name of the desired font in the Font List window. Use the 
scroll bars on that window to view more font names. The sample 
contains a text paragraph, followed by a complete upper and lower 
case alphabet for the font. Scroll the Font Sample window to see 
more of the sample.

Selecting Fonts
Many Fonter operations work on more than one font. To select multiple 
fonts in the Font List window, use normal Windows selection tools. For 
example, to select multiple fonts that are consecutive in the list, click 
and drag the highlight over the desired font names. To select multiple, 
non-consecutive files, hold down the <Ctrl> key while you click or 
drag over the desired fonts.

When You Add or Delete Fonts
If you add or delete fonts from Windows, or change printers, you'll 
need to update your font list. When you start Fonter, it checks its list 
against the list of actual Windows fonts. If it finds any discrepancies, it 
will update the list. If you want, you can also update the list with the 
File/Re-list Fonts command. 

On-Screen Options
You can alter many aspects of Fonter's display by selecting a number 
of options. All options are at the lower left of the Fonter window.

[Font Size]--To change the size of a font sample, click the arrow on 
the Font Size drop-down list, then click the size you want. The font 
size you select will display in the Font Sample Window and will be the 
font size used in printing font lists. You can also type a font size larger 
than 36 points directly in the Font Size window. Just click in the 
window, type the font size, then press <Enter>.

[Bold] and [Italic]--To display or print Bold, Italic, or Bold Italic 
samples, click the appropriate check box. These options also affect font
lists. 

[Show Custom Sample]--To view specific text in the Sample window, 
type it in the sample text box at the bottom left of the main screen. 
Click inside the box, then type your text. You can use the normal 
<Home> and <End> keys to scroll the text. After you type the text, 
click the [Show Custom Sample] box. Your custom text will display in
the Font Sample window. If this box is checked, that text will also 
appear in the Font List printouts.



Text Samples--You can also type directly in the Font Sample window. 
To do this, click in the window and type away. The Cut and Paste tools 
in the "Edit" menu work here, as do all Windows cut and paste shortcut
keys.

Fonter Command Buttons
[View Details] 
This button replaces the sample window with two lists which show you 
in detail the metrics for the current font, both in its current logical 
format and the overall Text Metrics values for this font. These values 
are highly technical, but most are self-explanatory. For more 
information on font metrics, you'll need to consult the Microsoft 
Software Development Kit or another Windows font reference. For most
users, this information is more than they'll ever need. This information 
is provided for professional typographers. To return to the normal 
display, click the [Hide Details] button.

[Full Screen]
Fonter offers a full screen display of characters for any font. To view 
this, click this button. You'll see a list of the keyboard characters, with 
ANSI codes.

Using the Full Screen Display
The full screen character display offers a number of options, called by 
the command buttons listed below:

[Extended Characters]--To view codes for foreign language and 
symbolic characters, click this button on the full-screen display.

[Normal Character]--To return to the normal character display, click 
this button.

[Zoom]--To view an enlarged character set, click this button on the 
full-screen display. To view an even larger sample, highlight a character
by dragging the mouse cursor over it while holding down the left 
mouse button. Then click the [Zoom] button again. You'll see a 200-
point sample of your character. To return to the normal full-screen 
view, click the [Normal Size] button.

[Return]--To return to the main Fonter Window, click this button in the 
full-screen display.

NOTE: As with the sample window, you can use the Full-Screen 
display's Edit menu to cut and paste selected characters. So you can 
copy a character into the clipboard, then switch to another application 



and paste that character.

[Keyboard]
This main window command button takes you to a display which offers 
a new view of your font. You'll see a keyboard image, with characters 
from the currently-selected font in their correct places on the keyboard.
This window also offers you a number of other options for viewing 
characters and even lets you create large clip art images of any 
character.

HINT: Use the Keyboard display to graphically show you what key to 
press to get a specific dingbat or symbolic character in any font. You 
can even print a sample of the keyboard to use outside of Fonter.

Using the Keyboard Display
The keyboard display shows a typical computer alphanumeric 
keyboard. On the key tops are the characters in the currently-selected 
font. When you first access the Keyboard display, the characters are in 
lower case.

[Upper] and [Lower] options--Use these option buttons to control 
whether the keyboard displays upper or lower case characters.

[Current Font] List--Identical to the Font List in the main Fonter 
window, this drop-down list box lets you select any font for display on 
the keyboard.

[Zoom Window]--You'll always see a large version of the current 
character in this window. To zoom a specific character, press the key 
for that character. The character will appear in the Zoom Window. Or 
use the Character Scroll Bar, described next. For some fonts, the entire
character may not fit on the screen. If you have a high resolution 
monitor, you can enlarge the Fonter screen to see more of the 
character.

[Character Scroll Bar]--Use this scroll bar to move quickly through 
the entire Windows ANSI character list. The current ANSI code appears 
near the center of the scroll bar. Click the arrows to move one 
character at a time. Click between the arrows to scroll 10 characters at
a time, or move the thumb for large changes. The current character 
appears in the Zoom Window.

[Save as .BMP]--This command lets you save the enlarged character 
in the Zoom Window as a Windows BMP clip art image for use in other 
programs. You'll see a dialog box, with the first four characters of the 
font name plus the ANSI code proposed as the filename. If you wish, 



you can edit the filename and path to suit your needs. 

NOTE: Even if the entire character doesn't show in the window, the 
BMP file will contain the whole character.

HINT: Try this feature to create clip art images from symbolic and 
dingbat fonts like WingDings. These images work very well in programs
like OsoSoft's Rockford! and Fonter when you need a large character.

[Return]--Use this menu command to return to the Fonter main 
window.

[Print Form]--Use this menu command to print a copy of the entire 
keyboard Window. If you do this for symbolic and dingbat fonts, you'll 
always have a handy reference on paper.

[ANSI Chart]
This main window command button opens still another window, this 
one containing a complete ANSI chart for the current font. In the chart, 
which is a grid, you'll see the normal ANSI character to the left of the 
ANSI character for the font you've selected in the main Fonter window. 
A status line will tell you what font you're looking at.
To read the chart, read across the top of the grid, then down, adding 
the number to the left to the number at the top to get the actual ANSI 
code for the character at any grid intersection.

You can print a copy of this chart with the [Print Chart] menu 
command. To return to the main Fonter window, select the [Return] 
menu command.

NOTE: With some fonts, particularly exceptionally wide or large fonts, 
some characters may stray out of their grid box. Most fonts, however, 
will display properly. Fonter makes a compromise which accommodates
most fonts well, in a size large enough to view easily.

PRINTING WITH FONTER 
While Fonter's on-screen display is useful, another of the program's 
functions is to print out lists and samples of your fonts. All printing 
commands are in Fonter's File menu. All Fonter printouts have a 1.25" 
left margin. If you print on 3-hole binder paper, it's easy to put your 
font lists and samples into a binder.

Printer Information
Fonter always prints to the default Windows printer. Once Fonter is 
running, though, you can always change printers with the Printer 



Setup command in the File menu. When you do this, Fonter 
automatically updates your font list to reflect the new printer.

PostScript Printers
Some PostScript printers have a limit to how many fonts can be 
downloaded to the printer. If you are unable to print complete font lists 
with your PostScript printer, try printing lists of selected fonts where 
the number is less than your printer's limit. Also, when using TrueType 
fonts, use the Printer Setup dialog to select Print True Type Fonts 
as Bitmaps option. While this will take longer to print, you'll avoid 
encountering your printer's download limits. If your printer can support
the Hewlett-Packard HPCL printer commands, you'll get faster results if 
you use a PCL driver instead of the PostScript driver.

Print Manager--On or Off?
OsoSoft recommends that you turn Print Manager off while printing 
with Fonter. While this slows down access to other Windows programs 
during printing, it also removes the possibility that you will generate 
TMP files larger than your disk space can handle. Use the Printer 
Setup application in the Control Panel to change this setting before 
starting Fonter. This is especially true when printing font books, which 
can generate enormous TMP files.

Printing Font Lists
List All Fonts--To print a list of all fonts installed in Windows for your 
current printer, give the File/Print List (All) command. The list will 
contain the name of each font, along with a text sample for that font. If
you have entered custom text and checked the [Show Custom 
Sample] box, that text will print. Font lists print in the font size 
selected in the Font Size drop-down list, up to 36 points. Font lists also 
use the Bold or Italic attributes.

NOTE: Some internal printer fonts have a fixed size. These fonts will 
print in their default size.

NOTE: Printing a complete font list can take several minutes. Please be
patient.
List Some Fonts--To print a list of just the fonts you've selected in the 
font list, give the File/Print List (Selected) command. The list is in 
the same format as described above.

Printing Font Samples 
Fonter can create two separate font sample sheets. One is a sheet 
displaying your selected font in several sizes from 3 to 60 points. This 
sample also displays Bold, Italic, Bold Italic and Underlined sample 



text, plus a complete list of the font's characters.
The second sheet contains an grid-like chart of every character 
available in the font. This chart lets you see the ANSI code for any 
character at a glance. You'll also see the normal Windows keyboard 
character or extended ANSI character. 

You can print either sheet, or both. Simply check the appropriate box in
the lower left corner of the Fonter Main window. The [Print ANSI Grid]
box controls the ANSI grid, while the [Print Text Sample] box controls
the sample sheet.

Single Font Sample--To print samples of the current font in the Main 
Font List window, give the File/Print Sample (Current) command.

Multiple Font Samples--To print samples of more than one font, add 
the fonts to the Selected Fonts window, then give the File/Print 
Samples (Selected) command.

NOTE: You can abort a multiple font sample printing job. Just click 
Fonter's [Exit] button with the hourglass cursor. Fonter will stop after 
printing the current font.
Printing Font Books

Fonter can also create font books, which contain both font lists and 
font sample sheets. Fonter first prints a list, as in the Font List 
commands, then prints samples for each font. Sample sheets print in 
the same way as described above. 

NOTE: Printing a font book for all fonts can take as long as 8 hours! 
Plan to print your font book at night, and make sure Print Manager is 
turned off to avoid running out of disk space.

Aborting Font Books--You can always abort font book printing. Just 
click Fonter's [Exit] button with the hourglass pointer. Printing will stop
after the current font.

WARNING: Check your printer's paper capacity. You'll be printing up to
two pages for each font. If you have too many fonts to print a complete
font book, print a complete font list, then a group of fonts. Use the 
File/Print Samples (Selected) command to print samples in smaller 
groups.

Complete Font Book--To print a font book for all fonts installed, give 
the File/Print Book (All Fonts) command.

Partial Font Book--To print a font book of just some fonts, select the 



fonts you want to print, then give the File/Print Book (Selected) 
command. 

GETTING HELP 
Use the commands below, in the Help menu:

Help/Fonter Help--You'll see a new window. On the left is a Topic 
Index. On the right is the Help information. To view help on a topic, 
simply click on that topic in the Topic Index. To return to Fonter, click 
the [Exit] button or the Return to Program command.

Help/About Fonter--view version information about Fonter and to find
the OsoSoft support access numbers.

Help/OsoSoft Program Information--You'll see an order form for 
OsoSoft products. To learn more about a product, click the [Info] 
button next to that product's listing. To order, type the number of 
copies for each product . The rest is automatic. Click the [Print] button
to print the form.

OTHER FONTER MENU COMMANDS
Options/Display ANSI Code--This command extends the Font Sample
to display the entire list of ANSI codes, along with the characters they 
represent for the current font. You can scroll through the Font Sample 
window to see any character.

Options/Make Current Font the Text Font--Normally, Fonter uses 
Arial on its printouts for all descriptive text. If you'd like to change this 
or if you've deleted that font, select another font, then give this 
command. You'll see the current font in a label just above the Font 
Sample Window.

Options/Save Text Font as Default--Once you've chosen a default 
text font with the command above, you can save this font name as a 
permanent default with this command. 

Edit/Custom Font List Text Sample--This command checks the 
[Show Custom Sample] check box and positions the cursor in the 
sample text editing area.

Previewing and Installing TrueType Fonts
New in this version of Fonter is the ability to preview TrueType fonts 
and install them in Windows for use by your applications. To switch to 
Fonter's Preview/Install mode, click the Preview/Install button. 
Some new command buttons will appear on the screen, while other 



commands, not appropriate to this operation, will disappear or be 
grayed out.

TrueType Font File List
At the bottom right of your Fonter window, you'll see a list of TrueType 
TTF files in the current directory. Use normal Windows file selection 
tools to change drives or directories to see the fonts you want to 
preview. NOTE: Whenever you jump to the Preview mode for the first 
time in a session, you'll start out in the WINDOWS\SYSTEM directory, 
the normal place for TTF files to be found. Whether a font is installed 
or not, you can view it in this mode. No checking is done to determine 
whether a font is currently installed.

Previewing a Font
To see a preview of the font contained in a TTF file, just double-click on
that filename. A font sample will appear in the normal Fonter sample 
Window. As with other installed fonts, you can click the View Details 
button to see font metric information.

NOTE: If a TrueType font file you select is corrupted or contains 
improper information, Fonter will display a message and refuse to load 
the font. The program will not install a font which contains invalid font 
name information.

Printing a Specimen of a Previewed Font
Click the Print Specimen button to print a full-page sample of the 
currently-displayed font. This sample is the same as the one printed 
from the normal Fonter command, and includes samples in various 
sizes and weights, along with a list of all extended ANSI characters. 
Print this sample to check the way the font will look when printed.

Adding a Font to The Print List
While previewing a font, you may want to add it to the list at the left of 
the screen to allow printing of a reference list for later installation or 
other purposes. To do this, click the Add to List button. Both the 
filename and the name of the font itself will be added. Whenever you 
wish, you can click the Print File List button to print a permanent 
record of fonts with their associated file names. HINT: Try this trick to 
print a reference list of file names which don't correspond closely with 
the name of the font they contain. It can be handy if you later want to 
delete font files, but can't remember the font name connected with a 
TTF file.

Installing TrueType Fonts Temporarily
It can be very useful to install a TrueType font temporarily for use in the
current Windows session. For example, suppose you are working on a 



project which requires the use of an unusual font, one which you didn't 
normally use. By starting Fonter and installing that font temporarily, 
you could use it without adding it permanently to your font list. 
Remember: The fewer fonts you have installed permanently in 
Windows, the faster Windows loads.

To temporarily install the font currently displayed in the sample 
window, click the Temp Install button. Fonter will add the font to the 
current Windows font list, and inform Windows that there is a new font 
available. This new font will show up in almost all Windows 
applications, and can be used just like any other font. However, when 
you exit Windows, that font will no longer be available.

NOTE: Temporarily installed fonts use memory and resources. While 
you can install up to 254 fonts in this way, it's recommended that you 
install no more than 24 fonts during any Windows session to avoid 
memory and resource problems.

CAUTION: if you use a temporary font in a document, then load that 
document in another Windows session without reinstalling the font, 
your application will substitute a replacement font for the uninstalled 
fonts. To resume work, you'll have to temporarily re-install the font 
again with Fonter.

Installing TrueType Fonts Permanently
Fonter can also install any TrueType font in Windows for permanent 
use. When you click the Perm Install button, the currently previewed 
font is installed. You'll be prompted for confirmation before the font is 
actually installed. You'll also be asked whether you want to also install 
the font for the current session. Since Windows normally must be 
restarted after permanently installing fonts for them to take effect, 
answering Yes to this prompt lets you use the fonts immediately as 
well.

Permanent Installation Notes
Fonter always copies a font you permanently install into the WINDOWS\
SYSTEM directory to avoid problems if fonts are accidentally deleted or 
if a CD-ROM disk containing the font files is removed from its drive. If 
you want to install the fonts in a different directory, add them to the 
Print List and install them later with the Windows Font Installer.

Installing a font permanently requires that information be written to 
your WIN.INI file. For safety's sake, Fonter always saves a backup 
copy of WIN.INI whenever you permanently install a font. This file is 
stored in your WINDOWS directory, with the name WIN.FNT.



Fonter will let you reinstall fonts which are already installed in 
Windows. This does no harm, and no changes are made to your 
WIN.INI file when that occurs. Don't worry about duplicate fonts at 
all...none will be created. The font and WIN.INI entry will simply be 
refreshed. TIP: If you want to avoid reinstalling existing fonts, print a 
font list from the main Fonter screen, then use that list for comparison 
while previewing fonts.

Returning to The Normal Fonter Display
To return to the normal Fonter display of installed fonts, click the 
Normal button. Fonter will resume normal operations after updating 
its font list to add any new fonts you've installed.

TROUBLESHOOTING 
Defective Fonts
Some public domain and shareware fonts, converted from another 
format, can cause problems in Windows programs. Fortunately, there's 
a way to spot these defective fonts in Fonter. Just follow these steps:

1. Start Fonter, then give the Options/Display ANSI Codes command

2. Click on each font, in turn, making a note of the font before 
selecting it. When you reach a defective font, Windows will generate an
error, possibly a General Protection Fault (GPF). When that happens, 
exit Fonter as gracefully as possible, under the circumstances, then 
delete that font, using either the ATM Control Panel or the Windows 
Control Panel Fonts dialog.

You can also spot defective fonts in a Fonter font list printout. A bad 
font may or may not print, but will corrupt printouts for later fonts. 
Again, the answer is to delete the offending font. Most often, it's not 
the first font that's not printed correctly that's defective, but instead, 
the one immediately before the first font that doesn't print correctly.

OTHER PROBLEMS 
PROBLEM: I can't get Fonter to install properly.
SOLUTION 1: Another program you've installed may have incorrectly 
installed some files with the same name as those used in Fonter, but in
the wrong directory. See README.WRI for complete manual 
installation procedures. You can view this file with the Windows Write 
application or in any Windows word processor.
SOLUTION 2: In a few cases, you may have to exit other Visual Basic 
programs which are running at the time you install Fonter. If you're 
prompted to do this, close all applications running in Windows, then 



repeat the Setup command as described earlier in this manual.

PROBLEM:Fonter won't run. 
SOLUTION: Check your installation. Make sure the VBRUN300.DLL, 
QPRO200.DLL, PPFONTS.DLL, COMMDLG.VBX,  and 
PPORIENT.DLL files are in the WINDOWS\SYSTEM directory.

PROBLEM:Fonter crashes.
SOLUTION 1: Check your Windows setup. Disable any programs 
running in the background, then try again. If it runs correctly, add the 
background programs one at a time until you have a problem. 
SOLUTION 2: If you're using a memory manager like QEMM, you may 
need to EXCLUDE certain portions of memory. Make a note of any 
memory block information you see if you get a General Protection Fault
Error, and use that as a guide to areas to EXCLUDE. 
SOLUTION 3: Make sure your Video and Printer drivers are current and
the correct ones for your version of Windows. Windows 3.0 drivers will 
not work reliably in Windows 3.1. 
SOLUTION 4: As a last resort, try running Windows with no add-ons at 
all. This may require a fresh installation. If you're having problems with 
Windows generally and with other Windows programs, this is probably 
your best solution.
SOLUTION 5: You have a defective font in your system. See the 
section of this manual on defective fonts for possible ways to detect 
this font.
SOLUTION 6: You've run out of disk space for Print Manager's TMP 
files. To eliminate this possibility, disable Print Manager in the Control 
Panel's Printer Setup dialog.

PROBLEM: Some fonts do not print in the size I expected. 
SOLUTION: Fixed-size internal printer fonts can only print in their 
default size, even if they display on the screen in other sizes.

PROBLEM: Fonter only prints part of my font list, then hangs up.
SOLUTION 1: Some printers restrict the number of fonts which can be 
placed on a single page. This is especially true of PostScript printers. If 
this occurs, use the Printer Setup dialog to print TrueType fonts as 
bitmaps, which prevents Windows from downloading the fonts. Printing
speed will be reduced.
SOLUTION2: If your printer can operate as a Hewlett-Packard PCL-
compatible printer, switch the printer to that mode and use a PCL 
driver as your default driver. 

PROBLEM: Some fonts print correctly, but do not display correctly on 
the screen.
SOLUTION: Internal printer fonts will not display correctly unless you 



have the proper screen fonts installed in Windows. consult your printer 
manufacturer to obtain the proper screen fonts for Windows 3.1.

PROBLEM: Why can't Fonter show fonts I have on disk but don't have 
installed in Windows?
SOLUTION: Fonter is normally  limited to displaying fonts which are 
currently installed in Windows. It has no way of knowing about other 
fonts. To see an uninstalled TrueType font, or to install new fonts, click 
the Preview/Install button. 

PROBLEM: I use MoreFonts and SuperPrint for some of my fonts. 
Fonter doesn't show me those fonts. Why not?
SOLUTION: Due to the unorthodox way some font scalers handle their
fonts, Fonter is unable to access their font lists. You may have similar 
problems with other programs. Consider converting your fonts to either
PostScript Type 1 or TrueType.

PROBLEM: I get a "Printer Error" message when I try to print your font 
lists.
SOLUTION: Contact your printer manufacturer for an updated version 
of your printer driver. OsoSoft and Fonter are not responsible for 
defective video and printer drivers. Windows drivers are the 
responsibility of the manufacturers. There are many outdated and 
defective drivers shipped with products. Typically, manufacturers fix 
these problems and make the new drivers available to their customers.
OsoSoft has tested Fonter on a wide variety of systems, and is 
confident that Fonter works properly on correctly-configured Windows 
systems. 

PROBLEM: Fonter seems to want to move TTF files to the 
WINDOWS\SYSTEM directory when I do a permanent installation. 
That's not what I want to do. I'd rather place TTF files in other 
directories.
SOLUTION: This is how Fonter works, and there's a reason for it. It 
would be easy for you to install a font permanently which was stored 
on a CD-ROM disk or one in a directory you might accidentally delete 
later. The location of the TTF file is stored in a FOT file and if the file 
does not exist in the proper location, Windows will not be able to find 
it. If you want to install font files in other directories, use the Fonts 
dialog in the Windows Control Panel, rather than Fonter.

PROBLEM: Fonter sometimes tells me that there's something wrong 
with a font I want to preview. However, the font seems to work properly
when I install it in another way. What's going on here.
SOLUTION: Fonter checks for a proper font name stored in the TTF 
file before it previews the font. If there is no name stored there, it flags 



that font as defective. While the font may work properly in Windows, 
that's a symptom of a possibly corrupt font. Fonter always takes the 
safe approach and refuses to install questionable fonts. You can install 
the font through the Control Panel's Fonts icon, but it's not 
recommended and you're on your own.

PROBLEM: Why can't Fonter install or preview PostScript Type 1 fonts 
as used in Adobe Type Manager?
SOLUTION: While Fonter can display ATM fonts which are already 
installed, it cannot preview these fonts or install them. Due to 
OsoSoft's inability to predict how Adobe may change ATM in the future,
it does not preview or install these fonts. Use the Adobe Type Manager 
Control Panel with these fonts.

PROBLEM: I temporarily installed some fonts with Fonter, but they 
don't show up in Word for Windows. I really want to use these fonts, 
but can't seem to find them.
SOLUTION: Fonter informs Windows that new fonts have been 
installed, but some programs don't refresh their font list automatically 
while they're running. Either exit the program and restart it to list the 
new fonts or select the File/Printer Setup command in the other 
program, then select Close. This will force the other program to 
update its font list, making the fonts available.

PROBLEM: Fonts I've installed with the Temp Install button just don't
show up at all in some of my programs. What's the answer?
SOLUTION: Not all programs handle logical fonts properly. If the tip 
above this one does not solve the problem, you'll have to install the 
fonts permanently.

PROBLEM: I installed a font with Fonter, but the next time I started 
Windows, the font didn't show up in my applications. What happened 
to it?
SOLUTION: You installed the font using the Temp Install button. 
When you do this, the font is installed only for the current session of 
Windows. If you want to use a font in a later session, use the Perm 
Install button instead.

PROBLEM: I don't understand the font metric information shown when
I click the Show Details button in Fonter. What does all that stuff 
mean?
SOLUTION: There's not room in this manual for a full description of 
font metrics information. The information is there primarily for the use 
of professional typographers. If you really want to learn about font 
metrics, call the OsoSoft BBS and download the file, TTINFO.ZIP, 
which contains more information.



PROBLEM: It's really interesting to see all those extended characters 
in Fonter, but how do I get them into other programs?
SOLUTION: That depends on the other program. Some offer a 
character inserter feature, but many do not. In all cases, however, you 
can manually enter the ANSI code for a character. Make sure the 
NumLock LED is on your keyboard, then hold down the <Alt> key 
while you type a 0 on the number pad, followed by the three digit code
for the extended character, as shown in the ANSI grid. Then, release 
the <Alt> key and the character will appear at your cursor location in 
the other program. NOTE: Some programs prevent you from doing 
this, but most allow it.

PROBLEM: On the list of fonts printed with Fonter, I get the name of 
the font printed in the previous line's font. This is bizarre.
SOLUTION: Fonter uses ARIAL as its default text font. If you've deleted
Arial, you'll see this effect. To fix things, either reinstall Arial in 
Windows or use the Default Fonts commands in the Options menu 
to assign a new text font.

Sources for Additional TrueType Fonts for Use in 
Windows
TrueType has become a de facto standard for fonts, largely due to how 
well Windows handles these scalable fonts. There are literally 
thousands of TrueType fonts available from a wide variety of sources, 
and these fonts are usually very inexpensive. 

You can find collections of interesting fonts sold by a variety of 
publishers in advertisements listed in almost every computer 
magazine. CD-ROM disks of fonts are also available, some of them 
containing over 1000 separate fonts.

There are also numerous shareware fonts available which you can try 
before paying for them. You can find these fonts primarily on online 
services, such as CompuServe, America On Line, and GEnie, along with
many other BBS systems.

On CompuServe, the best forum for locating fonts is the DTPFORUM. 
There are hundreds of specialized fonts available for your trial there.

You can also call the OsoSoft BBS, where a selected list of TrueType 
fonts is available for downloading. This list changes from time to time, 
as new shareware fonts is added to the list. It's a good source, and all 
fonts available on the OsoSoft BBS have been thoroughly tested.



Avoiding Troublesome TrueType Fonts
With all the free and shareware fonts available, there are also a lot of 
defective fonts in this category. In some cases, a defective font can 
cause a GPF or other problem in Windows. Here are some tips for 
avoiding these fonts before loading them:

Download only TrueType fonts with file dates prior to January 1, 1993. 
Fonts created earlier than that may have been converted from other 
formats with defective software.

Download fonts only from well-known online services. Normally, these 
fonts are tested before being made available.

Avoid cheap collections of hundreds of TrueType fonts. Often, these 
collections contain old and defective font files and can be troublesome.

Whenever possible, install new TrueType fonts temporarily, using 
Fonter, then test them before installing them permanently.

If Fonter's Preview mode displays a message saying that a font may be
defective, do not install that font. Fonter will not let you install a font 
which it thinks may be defective, but you can install these fonts 
through the Control Panel. OsoSoft recommends against this.

Some free and shareware TrueType fonts are poorly designed. Try 
printing a Specimen Sheet on all fonts before installing them 
permanently. Examine this sheet for good character spacing and 
consistency. If the font looks bad in the specimen sheet, it'll look bad in
your documents.


